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Disclaimer 

• You may not copy or reproduce part or all of the manual provided with it without express permission from 

SATO CORPORATION. 

• The contents of this manual are subject to change without notice for correction and improvement. 

• SATO CORPORATION cannot accept responsibility for the results of using this manual. 

• Every effort has been made to ensure the content of this manual is correct, but please contact us if you have 

any questions or concerns. 

 

• SATO, the SATO logo, and Multi LABELIST are trademarks or registered trademarks of SATO 

CORPORATION. 

• Microsoft and Windows are registered trademarks of the Microsoft Corporation in the United States. 

• Other company names or product names used in this manual are the trademarks or registered trademarks of 

their respective companies. 
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Introduction 

Multi LABELIST V5 enables you to design layouts for tags and labels, and print them easily. 

This manual provides training for creating label designs and the setups for making use of the various printing 

functions. 

This training is important in order to get the most out of Multi LABELIST V5, so please try to follow it. 

Note that the software will operate with limited features unless the HASP adaptor supplied with the production 

copy of Multi LABELIST V5 is used. 

 

 

Before Starting Training 

Is the program installation complete? 

Can Multi LABELIST V5 be launched? 

If HASP is not connected, the program will not operate normally. In such event as this isn’t possible, please refer 

to the Start-Up Guide. 

 

Then let’s start practice. 
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1: Basic Settings and Creating Text Objects 

 

 

With basic operations, we will create a layout according to a sample layout for practice. 

As the settings are basic, proceed with the practice while understanding the steps one by one. 

 

■ Sample layout for practice 

Printer model: CL4NX-J 08 

Name: Layout 

Label size: 45 mm x 70 mm (height x width) 

Print contents: Company name, Name, Phone No. 

 

 

We will now explain how to create a label as above. 

Let's get started. 

 

1. Creating a New Layout (Creating a Label Design) 

Select Windows Start Menu > Multi LABELIST V5 . 

The displayed location of “Multi LABELIST V5” may differ depending on your OS. 

 

Enter “user” as the password. 

Click “OK”. The MLDesign screen will be displayed. 
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The Layout Design screen starts. 
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2. Using Sample Layout 

From the File menu, select “New” then “Layout (Specify Sample Format)”. 
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Select a sample and click “OK”. 

 

 

Then you can use the selected sample layout. 
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3. Setting the Printer 

Make settings for the printer to be used. 

In “Basic Settings” of the Properties pane, select the printer in “Printer model:”. 

In this example, select “CL4NX-J 08”. 

In actual practice, select the printer you will use. 

*It may take several seconds until the “Select Printer Model” screen appears. 

 

 

Select the printer and click “OK”. 

  

Properties pane 
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4. Setting the Paper 

Then let’s make settings for the label paper to be used for the sample layout for practice. 

The size of the sample layout is 45 mm in height and 70 mm in width. 

Enter the value in Height and Width of Paper size.  

 

 

Did you enter the values? 

The size of an image of the label will be changed according to the entered values. 

 

  



Multi LABELIST V5 Training Manual - Various Print 

 

 

Multi LABELIST V5   13 

5. Creating Text 

Click “Text” then “Paste” on the Objects pane. 

 

 

Click on the area where you wish to create a text object on the Design screen. 
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When the text object is selected, the font type and size can be set in Basic settings on the Properties pane. 

 

 

In this sample layout, the company name is displayed in Chinese characters. 

Change the font type. 

 

 

In this example, “Arial” is selected. 
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Double-click the text “Error” and enter the company name. 

 

 

 

After entering the company name, press Enter. The company name will then appear on the image of the label. 

 

 

Is it displayed? 

 

Then enter the name and telephone number in the same way. 

Then compare it against the completed label diagram shown below. 

 

 

Is your label complete? 

 

That’s the end of layout design creation. 



Multi LABELIST V5 Training Manual - Various Print 

 

 

Multi LABELIST V5   16 

6. Saving the Layout and Exiting ML Design 

Select “Save” from the File menu, name the file for example “Layout”, and save it in your desired location. The 

saved file can be used later. 

 

 

From the File menu, select Exit to finish MLDesign.  

Thank you for your efforts! 
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7. Printing the Layout 

Double-click the “Layout.mllayx” file saved before in order to start MLPrint. 

 

Enter the number of copies to be printed in “Print quantity” then click “Start Printing”. 

 

 

Is the label printed? 

 

This is the end of “1: Basic Settings and Creating Text Objects”. 
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Useful Functions 

 

1. Print Alignment Function 

You can align multiple print items to the top or center with a click of a button. 

 

Now we are ready to print. Move the mouse to select multiple items to be aligned. 

 

 

Select “Left” from the Position menu. 

 
 

Is the top position for the selected items aligned? 

Let's check the other buttons. 
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2: Editing Entered Items and Print Screen 

 

 

We will now go to the next step, based on what we learned in “1: Basic Settings and Creating Text Objects”. Also 

review “1: Basic Settings and Creating Text Objects” when required. 

 

We will use the sample layout created in “1: Basic Settings and Creating Text Objects” for practice. 

In “1: Basic Settings and Creating Text Objects”, we created text objects directly on a sample layout (“Layout”). In 

this section, insert a company name, name, and a telephone number when printing the label. 

 

■ Sample layout for practice 

Printer model: CL4NX-J 08 

Name: Layout 2 

Label size: 45 mm x 70 mm (height x width) 

Print contents: Company name, Name, Phone No. 

 

We will explain how to create the sample layout as shown above. 

Let's get started. 

 

1. Opening the layout file 

Select Windows Start Menu > Multi LABELIST V5 . 

The displayed location of “Multi LABELIST V5” may differ depending on your OS. 

 

Enter “user” as the password. 

Click “OK”. The MLDesign screen will be displayed. 
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From the File menu, click “Open” then “Layout...”.  

 

 

Select the layout created in “1: Basic Settings and Creating Text Objects”, and click “Open”. 
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The layout created in “1: Basic Settings and Creating Text Objects” is displayed. 

 

 

Is it displayed? 

 

Then go to the next step. 
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2. Creating a Variable 

We will create a layout by entering “Company name,” “Name” and “Phone No.”, and print it. 

In this section, we will create variables to assign to these print items. 

 

Let's open the Variable Settings screen. 

Click “Add” on “Local Variable List” at the lower part of the screen. 

 

 

 

  

Multi LABELIST V5 has “Global variables” and “Local variables” as variables. 

“Local variables” are unique information that can only be used in the layout being created. They are stored 

in a layout file. 

“Global variables” are the global information that can be used by another layout. They are stored in a 

global information file other than a file for layout. 

Global information file 

Layout file 

Global 

Variables 

Local 

variables 

Layout file 

Local 

variables 

Label 

Design 

 

Label 

Design 
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Setting items depend on the type of Variables. 

Type Description 

Input Set variables of text such as product name or price that is input when printing.  

Copy Set a variable that is a duplicate of another variable. By switching between “Before editing” 

and “After editing”, specify whether to copy the original variable value or to copy the 

variable value after editing such as comma editing. 

Join Set a variable that joins the fixed value and variable. 

Sequential 

number 

Set variables that include condition settings such as count up by 1 or count down by 2, etc. 

Date Set variables such as the current date and time and the date and time after adding the 

elapsed value. 

Calculation Set variables for calculation formula such as four arithmetic operations. 

Symbol Set variables for special symbols that set application identifiers (AI) such as GS1-128 

barcodes in data. 

 

 

In this example, we will use an Input variable. 

Select “Input” as the variable type and “Character” as the Input variable type. Then enter “Company Name” as the 

Variable name and “20” as the No. of digits and click “OK”. 
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The input variables are displayed on the Local Variable List. 

 

 

Is it displayed? 

Enter “Name (10 digits)” and “Phone No. (12 digits)”, using the same procedure. 

 

Then the screen shown below is displayed. 

 

 

Is it displayed? 

 

We will continue the practice, using these variables. 
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3. Assigning Variables 

Assign the variables set in the previous steps to the layout created in “1: Basic Settings and Creating Text 

Objects”. 

Display the set variables. 

 

Method 1: Drag & drop the variables from the Local Variable List. 

While keeping the company name clicked on the Local Variable List, move the mouse to the object to which the 

variable is to be assigned, and release the mouse when the color of the frame around the object changes to 

yellow-green. 

 

 

The display changes to “?????????...”. 
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Method 2: Select on the Properties Pane 

Click the target object. 

 

 

Set “Data” in “Basic settings” on the Properties pane to “Variable” and click “Name”. 

 

 

 

 

 

 

 

 



Multi LABELIST V5 Training Manual - Various Print 

 

 

Multi LABELIST V5   27 

 

The Select Variable dialog box is displayed. Select the variable to be connected and click “Select”. 

 

 

The selected variable is connected to the text object. 
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Assigning Variables 

Using the same method as Method 1 or Method 2, assign the variables “Name” and “Phone No.” to the 

corresponding items in the layout. 

 

Does your Design screen look like as shown below? 

 

 

This completes creating the design. 

 

Then we will go to the next step to create the print screen for printing a name label. 
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4. Saving the Layout 

Change the name of the currently opened file “Layout.mllay” to “Layout2.mllay” and save it. 

 

Select “Save As... ” from the File menu. 

 

 

Enter the file name and click “Save”. The file is saved with the new name. 

 

 

  



Multi LABELIST V5 Training Manual - Various Print 

 

 

Multi LABELIST V5   30 

5. Creating the Print Screen 

Create the print screen. 

 

To display the print screen, click the “Input Definitions” tab at the top left of the layout Design screen. To change to 

the layout Design screen, click the “Design” tab on the print screen. 

 

 

 

Is the screen shown above displayed? 

 

Start the practice from the print screen. 
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To print the label, what you only need to do is enter the data and the print quantity, and send the print instructions, 

regardless of the design. Creating the print screen independently of the design makes it possible to print labels 

easily and quickly. 

 

Then let's create the print screen. 

 

The “Company Name”, “Name”, and “Phone No.” are displayed in the header. 

Move these three input items to the Row section. 

 

 

 

 

 

 

 

  

Operations differ depending on whether the input item is in the Header or the Rows section. 

Items in the Header are added to all Rows. 

 

As an example, the same data are input on the print screens below. 

Header 

Rows 

Meguro  

Destinations 

No. Product 

Name 

 

1  

2  

Orange  

Banana  

No. Destinations Product Name 

1  

2  

Meguro Orange 

Meguro Banana 
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Let's try moving items from the Header to the Rows. 

 

Click “Company Name” and then drag and drop it to the Rows section. 

 

 

 

Does your screen now look like the figure below? 

 

 

Move the “Name” and “Phone No.” items to the Rows using the same method. 
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Then sort the input items. 

 

Move the input items for “Company Name” to the left of Print quantity. 

Click the title for “Company Name”, and then drag and drop it on “Print quantity”. 

 

 

 

Does your screen now look like the figure below? 

 

 

Move “Name” and “Phone No.”, using the same method. 
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Does your screen now look like the figure below? 

Save the current status of the screen. 

 

 

In this practice, we will use the print screen we just designed. 

Now, let's enter data and print a label. 

 

■ Complementary Information: Move the row items to the Header section 

Click the title row of “Company Name” and drag and drop it to the Header section. 

 

 

Is the item moved to the Header section? 
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6. Printing the Layout 

We will print the label based on the layout and the layout print screen that have been created. 

 

When you have finished creating the layout, be sure to save it. 

If you finish creating the label without saving, the contents that you have created or changed will be lost. 

 

Double-click the “Layout2” file that has been saved. 

 

 

Enter each item and click “Start Printing”. Printing the label will start. 

 

 

Is the label printed? 

 

This completes “2: Editing Entered Items and Editing the Print Screen”. 
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3: Making Various Characters 

 

 

Let's try applying what we learned in 1. Basic Settings and Creating Text Objects, and use various characters. 

 

1. Fixed Characters 

This is an application of “1. Basic Settings and Creating Text Objects”. Let's try setting a fixed value and 

presenting characters. 

 

Use the Printer font. 

 

 

 

Open the design screen for layout registration from MLDesign in Multi LABELIST V5, and create a new layout. If 

you don’t remember how to create a layout, refer to “1. Basic Settings and Creating Text Objects”. 

 

■ Basic Settings for the Layout 

Printer model: CL4NX-J 08 

Label size: 45 mm x 70 mm (height x width) 

 

  

“Printer font” is a character font built-into the printer, which allows fast printing and reduces the amount of 

data that has to be sent. 

 

Characters used in “1. Basic Settings and Creating Text Objects” is “Windows fonts”. 

As “Windows fonts” are treated as image data, the printing process may be slow, and the amount of 

transmitted data may increase. When “Windows fonts” are used, larger characters will be produced with 

higher-resolution results compared with “Printer fonts”. 
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Select “Text” on the Objects pane and enter “12345”. 

 

 

As default, Font Type is “Windows fonts”. Select “Printer fonts” and “X21” and specify Size (Magnification) to 2 for 

H (height) and 3 for Width. 
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Did you enter the values? 

 

Enter “ABCDE”, using the same method. 

Specify “Printer fonts” to “X23” and 2 for H (height) and 2 for Width. 

 

 

Does it look like the screen as above? 

 

Then go to the next step. 
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2. Rotating the Characters and the Design Screen 

First, let's practice rotating the displayed characters. 

 

Select the item you want to rotate. (You can select the item by clicking it with your mouse.) 

 

 

Click “Rotate” on the tool bar to display the sub-menu and select the type of rotation. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

Original position 

Rotate Right 90° Rotate Left 90° Rotate 180° 
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Do you understand how to rotate the selected text? 

Then rotate multiple items. 

 

Select the area where there are items to be rotated. 

 

 

 

When you specify the area, characters in the area are selected. 
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Click “Rotate180°” of “Rotate” on the tool bar. 

 

 

Did the character items turn as shown below? 

 

 

Until now the items are selected and rotated. The MLV5 can change the print direction so that you can create a 

label as usual and print it by turning by 90° or 270°. 

 

For example, to print the label rotated by 90° or 270° from the normal direction (characters can be read normally) 

as shown below, you have to rotate the objects or you have to tilt your head to check the label balance. 

 

 

  

Print direction 
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To create a new layout, make settings as described below. 

Printer model:CL4NX-J 08 

Label size:45 mm x 70 mm (height x width) 

 

Click the arrow button at the top left to change the print direction. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

When the arrow direction is 90° or 270°, the orientation of the paper is changed. 

The arrow changes as shown below each time the button is clicked. 

    

 

Design the label by setting the arrow direction to 90°, and print it. 
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Is the label printed in the direction shown below? 

 

  

Print direction 



Multi LABELIST V5 Training Manual - Various Print 

 

 

Multi LABELIST V5   44 

3. Starting a New Line 

If there are too many characters in the print item and they cannot fit into the label area, you can start a new line 

and perform multi-line printing. Let's practice to start a new line easily. 

 

■ For the text to paste 

Click “Text” on the Objects pane. 

 

 

 

Enter the characters before starting a new line. 
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To start a new line, press the Enter key while holding down the Ctrl key. 

 

 

 

Enter the characters on the next line. 
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Enable the “Line feed” button on the Basic setting pane. 

 

 

 

How does that look? 

Could you start a new line? 

 

 

 

When the “Line feed” button is disabled, you cannot start a new line on the Preview. 
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You can also start a new line in character strings that have already been pasted. 

 

Display the Basic settings pane for the text to paste. 

Move the cursor to the point where you want to start a new line and press the Enter key while holding down the 

Ctrl key. 

 

 

Enable the “Line feed” button. 

 

 Could you start a new line?  
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■ For the input variable character 

Click “Advanced...” on the Basic settings pane for the input variable character 

 

 

Enable the “Line feed” button in “Adjust text” block on the Printer Font Settings screen. 
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Setting items for Line-feed settings depend on the Font type. 

 

･When Printer fonts are used 

Set the “Pitch between lines” and “No. of line feed digits (Line-feed character length)” and then click “OK”. The 

display, “No. of line feed digits” or “Line feed character length”, depends on the font selected. 

 

 

･When Windows fonts are used 

Set the “Pitch between lines” and “Line feed character length”, and then click “OK”. 

 

 

Can you start a new line? 

The line-feed method for “Input variable character” is also used for “Text to paste”. 

Line feed is enabled using the Line-feed character length without using Ctrl+Enter. 
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4. Editing Characters 

Up to now, we have printed entered characters and set characters as they are. In this section, we will edit the 

entered characters to make them easier to read or to enter them easily. 

 

This example shows how to add “¥” and “,” to the entered characters when printing the price. 

 

Set variables for editing characters. 

Add “Price” to the variable used in “2: Editing Entered Items and Editing the Print Screen”. 

 

■ Comma editing and currency editing 

Open the layout and click “Add” in “Local Variable List” at the lower part of the screen. 

 

 

 

 

 

 

 

 

 

Select “Input”. 
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Set “Setting items” for “Comma editing” on the “Edit parameters” tab to “Single-byte”. 

 

 

Select “Setting items” for “Currency editing”, check “Edit currency”, select “¥” for “Character”, and click “OK”. 

 

 

Enter “Price” in Variable name, set “8” in No. of digits, and click “OK”. Then the variables are added. 
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Are they displayed? 
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■ Leading zero editing 

If you wish to automatically add 0s (zeros) to the start of the character string, use “Leading zero editing”. 

 

Open the layout and click “Add” in “Local Variable List” at the lower part of the screen. 

 

 

Select “Input”. 

 

 

Set “Leading zero filling” on the “Edit parameters” tab to “Yes”. 
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Set “Leading zero filling” in Variable name, “10” in No. of digits, and click “OK”. Then the variables are added. 

 

 

Set variables for “Price” and “Leading zero filling” to the print items using the procedure in “2: Editing Entered 

Items and Editing the Print Screen” and print it. 

 

■ Preview of Editing Results 

When editing ¥ Fill or Zero Fill in Variables, the results after editing can be checked in preview. 

 

Double-click the variable “Price” created before. 

Enter the original value in “Target character” and click “Preview”. Then the value after “Comma editing” and 

“Currency editing” set in “After editing” is displayed. 

 

 

When “1200” is entered, “¥1,200” is displayed. 
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5. Copying Characters 

As practiced in the previous procedure, there may be a case to print with “¥” or “,” filling for one and with “Zero Fill” 

for another for one Input item. 

In this situation, use the variable “Copy” for editing. 

 

“Copy timing” of “Copy” enables you to select when the target variable is to be copied, “Before editing” or “After 

editing”. “Before editing copy” copies the value before editing such as the input value of input variables and “After 

editing copy” copies the value after editing the input value, using the settings for Edit parameters such as Comma 

editing. 

 

We will now practice “Before editing copy” and “After editing copy”. 

 

Specify “Before editing copy” and “After editing copy” for one Input Variable. 

 

Create a new layout. 

･Basic Settings 

Printer model: CL4NX-J 08 

Label size: 45 mm x 70 mm (height x width) 

 

･Variable Settings 

(1) Variable name: Price 

 Number of characters: 8 

 Edit: “¥” editing, “Comma” editing, Right align 

 

(2) Variable name: Leading zero filling 

 Number of characters: 10 

 Edit: Leading zero editing, Right align 

 

  

 

Could you set the variables? 
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■ Before editing copy 

Click “Add” in Local Variable List to display the Variable Settings screen. 

Select “Copy” and “Before editing” for Copy timing. 

 

 

Select “Price” for Copy variable and set “Start position” to “1” and “End position” to “8”. 

 

 

Enter “Copy Price Before Editing” in “Variable name”, set “8” in “No. of digits”, and click “OK”. Then the variable is 

added. 
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■ After editing copy 

Click “Add” in Local Variable List to display the Variable Settings screen. 

Select “Copy” and “After editing” for Copy timing. 

 

 

Select “Price” for Copy variable and set “Start position” to “1” and “End position” to “8”. 

 

 

Enter “Copy Price After Editing” in “Variable name”, set “8” in “No. of digits”, and click “OK”. Then the variable is 

added. 
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Does it look like the screen shown below? 

 

 

Using the same method, add variables to “Before editing copy” and “After editing copy” for Leading zero filling. 

 

Could you make settings as shown below? 
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Reflect these settings in the layout design. 

 

 

Could you reflect the settings in the design? 

 

Now we are ready to print. 

 

Make sure to save the layout before closing the design. 

Save as “Copy Practice.mllayz”. 

 

 

  

Copy Price Before Editing Copy Price After Editing 

Copy Price Before Leading Zero Filling Copy Price After Leading Zero Filling 
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6. Checking the Print Results 

Double-click the layout file saved in the previous procedure. 

 

The print screen of MLPrint starts. 

Enter “1000” in “Price” and “5000” in Leading zero filling. 

 

 

Does it look like the printout shown below? 

 

 

This completes “3: Making Various Characters”. 

  

Value you entered Value after editing 
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Useful Functions 

 

■ Opening the screen from the layout file 

You can open the print screen and design screen by right-clicking or double-clicking a file directly, 

as well as by opening it from the menu. 

 

･Opening the print screen 

Method 1. Double-click a layout file. 

Method 2. Right-click a layout file, and then select “Open”. 

 

 

･Opening the design screen (MLDesign) 

Right-click a layout file, and then select “Edit”. 

 

  

Double-click 

Right-click menu 
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4: Creating Barcodes and Making Various Settings for Barcodes 

 

 

Let's try creating a barcode and using various editing functions. 

 

1. Creating a Barcode 

In this section, we will set a fixed value and present a barcode. Also, we will add a description character to the 

barcode. 

 

 

 

■ JAN/EAN code 

Create a new layout in MLDesign. 

Printer model: CL4NX-J 08 

Label size: 45 mm x 70 mm (height x width) 

     

 

 

Are they displayed? 

 

  

“Description character” is for alphanumeric characters and symbols written under a barcode to describe 

the content of the barcode. It has various notation methods for the barcode such as containing the entire 

content of the barcode or only part of the content. 

 

 

Barcode 

Description character 
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Click “Barcode” on the “Objects” pane. 

 

 

Move the mouse cursor to the position you wish to print the barcode, and then click. 

 

 

 

 

 

 

 

 

 

 

 

  



Multi LABELIST V5 Training Manual - Various Print 

 

 

Multi LABELIST V5   64 

 

The barcode is pasted. 

 

 

Make settings for “Basic settings” on the Properties pane. 

Enter the barcode data in “Data”, select “JAN/EAN13” in Type and “Yes (guard bar disabled)” in H.Readable in 

Barcode settings. 
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To set the font for the description character, click “...” to display the Barcode Description Character Font Settings 

screen. 

 

 

 

 

 

 

 

 

 

 

 

Open “Advanced settings” on the Properties pane and select “JAN/EAN (modulus 10)” in C/D add. 

If the entire data of 13 digits are input as data without C/D, select “No”. 

 

 

In “Attribute settings”, numeric values can be set for the print position (unit: mm). 

 

Is the barcode displayed? 
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■ CODE39 

Multi LABELIST V5 can automatically add start/stop codes used in some barcode types such as NW-7 and 

CODE39. 

 

Add them to a layout you created in “JAN code”. 

 

 

Click “Barcode” on the “Objects” pane. 
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Move the mouse cursor to the place you wish to print the barcode, and click the mouse. 

 

Make settings for “Basic settings” on the Properties pane. 

Enter the barcode data in “Data”, and select “CODE39” in Type, “Yes” in H.Readable, and “2”in Level in Barcode 

settings. 

 

 

 

Enter “*”in the Start code and Stop code of “Advanced settings”. 

If the input data includes the start and stop codes, select “No”. 

 

 

In “Attribute settings”, numeric values can be set for the print position (unit: mm). 
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Is the barcode displayed? 
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2. Join 

Some barcode may contain not only one character string, as practiced up to here, but multiple items in one 

barcode. 

For example, in the JAN code, a barcode contains several items such as “Country code”, “Manufacturer code”, 

“Item code”, and “CD”. 

To combine multiple items in one barcode, use a variable “Join”. 

 

 

 

 

 

 

 

 

 

 

 

■ Creating a JAN code using Join 

Create a new layout in MLDesign. 

Printer model: CL4NX-J 08 

Label size: 45 mm x 70 mm (height x width) 

     

 

 

Are they displayed? 

 

  

Country code 

Manufacturer code 

Item code 

Check digit 

JAN code 

Join 

Barcode Object 
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Create variables using what we learned in “2-2. Creating a Variable”. 

(1) Variable type: Input 

 Variable name: Manufacturer code 

 Number of digits: 5 

 

(2) Variable type: Input 

 Variable name: Item code 

 Number of digits: 5 

 

Could you make settings as shown below? 

 

 

Then we can create a join item. 
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Click “Add” in Local Variable List. 

Select “Join” on the Variable settings screen. 

 

 

Select “Fixed” in “Type” and enter “49” in “Data”. 

 

 

Select “Variable” in “Type” and enter “Manufacturer Code” in “Data”. 
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Select “Variable” in “Type” and enter “Item Code” in “Data”. 

 

 

Enter “Barcode” in “Variable name” and click “OK”. 

 

 

Could you enter variable items as shown below? 
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Set the created “Join” in the barcode object shown below as data. 

Barcode type: JAN/EAN13 

Add description character: Yes (guard bar disabled) 

C/D add: JAN/EAN (modulus 10) 

 

Does it look like the screen shown below? 

 

 

Now enter a “Manufacturer code” and “Item code”, using MLPrint, and check the print results. 
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3. Sequential Numbers 

You can add a sequential number to the label. 

Depending on the layout of the label, sequential numbers such as serial numbers and lot numbers can be printed. 

In this section, we will practice how to add sequential numbers. 

 

Create a new layout in MLDesign. 

Printer model: CL4NX-J 08 

Label size: 45 mm x 70 mm (height x width) 

 

 

Click “Add” in Local Variable List. 

Select “Sequential number” on the Variable Settings screen. 
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Enter “1” to “999” in Sequence number range. 

A sequence number can be changed in any steps for one count by changing Increment/decrement value. 

For example, when 2 is entered in Increment/decrement value, the result will be “1, 3, 5, 7, 9...” 

 

 

Enter “Sequence number-1” in Variable name and “3” in No. of digits and click “OK”. 

 

 

To edit the Sequence number print such as “Justification”, select the “Edit parameters” tab and make settings. 
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Could you make settings as shown below? 

 

 

Try to print the Sequence number that has been set. 

Assign the created variable “Sequence number-1” to the text object. 

 

 

Could you make the settings? 

Enter the “Print quantity” in MLPrint and check the print. 
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4. Graphics 

When printing labels and tags, you may need to print not only characters and barcodes but also images such as 

the company's logo or items being sold. To print graphics, select “Graphic” on the Objects pane. 

 

 

 

Create a new layout in MLDesign. 

Printer model: CL4NX-J 08 

Label size: 45 mm x 70 mm (height x width) 

 

 

Click “Graphic” on the Objects pane. 

 

  

To create Graphics in Multi LABELIST V5, you need to prepare graphic files in BMP format in advance. 

Create graphic files using applications such as Windows “Paint” or other commercially available image 

editing software. 
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Move the mouse cursor to the place you wish to print the graphic and click the mouse. 

 

The file selection screen is displayed. Select the graphic file that has been made and click “Open”. 
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The selected graphic is pasted. 

 

 

Details for the graphics can be set on the Properties pane. 

It is not necessary to change the settings in this case, but it is recommended to try various settings. 

 

Print the label of the created layout in ML by entering the value in the Print quantity. 
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5. Date 

You can use the variable “Date” to print a best-before date for food products or a production date. 

The date is printed referring to the Calendar on your computer. 

 

Create a new layout in MLDesign. 

Printer model: CL4NX-J 08 

Label size: 45 mm x 70 mm (height x width) 

 

 

Click “Add” in Local Variable List. 

Select “Date” on the Variable Settings screen. 
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Click “...” in “Print format”. 

 

 

The Edit Data and Time Format screen opens. Select “Format”. 

Sample format patterns are displayed. 

You can select a format from the list of patterns or input the date, referring to “Format list”. 
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Set “Western calendar year (4 digits)”, “Month (2 digits)”, and “Day (2 digits)”. 

Double-click the selected format on the Format list to display it in “Format” and click “OK”. 

 

 

Enter “Today” in “Variable name” and click “OK”. 
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Could you make settings as shown below? 

 

 

Add the setting to display the date three days after with the Variable name of “After 3 days”, using the same 

method as above. 

 

 Click the column of “Passed value:” and make settings shown below. 

Add the passed value: Enabled 

Passed value type: Fixed 

Pass direction: Future 

Pass date and time: 3 Day 

When you complete settings, click “OK”. 

 

 

  

“Passed value” is the value to show how many days and hours have passed after the date and time that 

have been set (based on the computer’s calendar in this case). Entering the above values, the date added 

the passed value will be displayed and printed. 
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Enter “After 3 days” in Variable name and click “OK”. 

 

 

Could you make settings as shown below? 
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Reflect the settings in the Print Items. 

 

To set the titles “Today” and “After 3 days”, set the text to paste and place the characters to which the variables 

are assigned on the right of each text string. 

 

 

Could you reflect the settings in the print items? 

 

Enter the Print quantity in MLPrint and print the label. 

Does the print result look like the screen on the left? 

 

 

This completes “4. Creating Barcodes and Making Various Settings for Barcodes”. 

  



Multi LABELIST V5 Training Manual - Various Print 

 

 

Multi LABELIST V5   86 

5: Creating Tables 

 

 

The “Table” function enables you to convert a value, using the input value as a key. 

 

In this section, we will practice creating a table. 

 

1. Creating a Table 

Create a new layout in MLDesign. 

Printer model: CL4NX-J 08 

Label size: 45 mm x 70 mm (height x width) 

 

 

Click the “Local Table List” tab at the lower part of the screen and click “Add”. 
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Enter the table items. 

 

 

■ Base information for tables 

Item Description 

Input Permission 

Item Type 

Select “Numeric” or “Alphabet” that is to be set in “Conversion value”. 

Conversion value Enter the value used as the key to recall the table when printing. 

Conversion range To specify the range such as “Convert the value from 10 to 20 to something”, enter the 

last value of the range. 

Example) To convert 10 to 20, set “Conversion value: 10” and “Conversion range: 20”. 

Condition Select “= (equal)” or “< > (not equal)”. 

Conversion A Enter the content for the entered Conversion value. 

 

 

Enter “Table” in Table Name and the values in Conversion value, Condition, Conversion A. 
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Enter as shown below. 

When you complete entering the required data, click “OK”. 

 

 

Could you add a table as shown below? 
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2. Creating Table Variables 

In this section, we will assign the table we created to a variable. 

Click the “Local Variable List” tab at the lower part of the screen and click “Add”. 

 

 

Select “Input”. Then select “Character” in Input variable type and click “Setting items” of Table conversion. 
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Enable the check box “Convert table”, select ”Table” in Table name (table created in 5-1. Creating a Table) and “A” 

in Cell item (“Conversion A” when creating a table), and click ”OK”. 

 

 

Enter “Table” in “Variable name”, set “2” in “No. of digits”, and click “OK”. 

 

 

 

Are the variables set as shown below? 

 

 

This can now be reflected in the design. 
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3. Reflecting a Table in the Layout Design 

Click “Text” on the Objects pane and click the position on the Design screen where you want to print. 

 

 

 

 

 

 

Drag and drop the “Table” created before to the text object on the Design screen. 
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When the text “Error” changes to “??”, the assigning of the variable is completed. 

 

 

To make the text larger, change the Size of Font on the Properties pane. 

 

 

Does it look like the screen shown below? 

 

You can now save the file with the name “Table”, print it, and check the results.  
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4. Entering Table Items and Printing 

Select a layout file created and double-click it. 

 

 

The Print screen is displayed. 

 

 

Enter the table items and check the result. 
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Select “01” in “Table”. Then “Blue” is printed. 

 

 

Select “02” in “Table”. Then “Red” is printed. 

 

 

Select “03” in “Table”. Then “Yellow” is printed. 

 

 

 

This completes “5: Creating Tables”. 

  

Blue 

Print result 

Red 

Yellow 

Print result 

Print result 
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6: Setting the Input Check Table Function 

 

 

When you intend to perform various checks on the entered data, use the “Input Check function”. 

To limit the input value to that registered in the table, use the “Check Table”. 

 

We will now practice making settings for the input check table. 

 

1. Creating a Check Table 

Create a new layout in MLDesign. 

Printer model: CL4NX-J 08 

Label size: 45 mm x 70 mm (height x width) 

 

 

Click the “Local Check Table List” tab at the lower part of the screen and click “Add”. 

  



Multi LABELIST V5 Training Manual - Various Print 

 

 

Multi LABELIST V5   96 

 

Enter the check table items. 

 

 

■ Base information for a Check Table 

Item Description 

Input Permission 

Item Type 

Select “Numeric” or “Alphabet” that is to be set in “Value x”. 

Numeric:  Enter a number from 0 to 9 as the valid value. 

Alphabet:  Enter Chinese characters and alphanumeric characters as the 

permissible value. 

Value 1 Enter the value to perform the input check when printing. 

Range 1 To specify the range, enter the last value of the range. 

For example, to specify the range 10 to 20, set “Value: 10” and “Range: 20”. 

Condition 1 Select “= (equal)” or “< > (not equal)”. 
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Enter “Check Table” in Table name and set “Value” and “Condition” as shown below. 
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2. Creating a Variable for the Check Table 

In this section, we will assign the check table we created to a variable. 

Click the “Local Variable List” tab at the lower part of the screen and click “Add”. 

 

 

 

Select “Input”. Then select “Character” in Input variable type. 

 

 

Enter “Check Table” in Variable name, set “6” in No. of digits, and click “OK”. 
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Are the variables set as shown below? 

 

 

 

This can now be reflected in the design. 
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3. Reflecting Variables Created in the Layout Design 

Click “Text” on the Objects pane and click the position on the design screen where you want to print. 

 

 

 

 

 

 

Drag and drop the “Check Table” created before from the Local Variable List to the text object on the Design 

screen. 
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When the text “Error” changes to “??????”, the assigning variable is completed. 

 

 

Are they displayed? 

 

Then change the screen to “Input Definitions” and make input check settings. 
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4. Making Input Check Settings 

Click the “Input Definitions” tab at the top of the layout screen to switch the screen. 

 

 

Click the item for which the input check is to be set. 
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Click “Input check” on the Properties pane to open the setting screen. 

 

 

Enable the check box “Perform input check”, select “Check table” in Other check type and Table name (created in 

6-1. Creating a Check Table) and “1” in Condition (“Value 1” when registering a check table), and click “OK”. 
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When you return to the Input Definitions screen, click “Print Action” on the upper part of the Home ribbon. 

 

 

The “Print Action Settings” screen opens. Click “Input settings”, check the check box of “Check data during input”, 

and click “OK”. 

 

 

When you have finished making settings, save the file with a new name such as “Check table”, and check the 

results on the Print screen. 
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5. Checking the Input Check Function on the Print Screen 

Select a Check Table file created and double-click it. 

 

 

The Print screen is displayed. 
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Enter the value in the input check table, and check whether any values that have not been registered to the “Input 

check table” will return an error. 

 

The values shown below are entered in the input check table. 

 

 

When “Meguro” is entered in the check table, it is enabled to input. 

 

 

If “Osaki” is entered in the check table, it is checked and an error message of Input Check is displayed. 

 

 

This completes “6. Setting the Input Check Table Function”. 
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